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Preface


This document is a formal contract deliverable with an approval code 1.  It requires Government�
review and approval prior to final contract acceptance. This document is under ECS contractor�
configuration control. Contractor approved changes are handled in accordance with the change�
control requirements described in the EOS Configuration Management Plan. Changes to this�
document will be made by document change notice (DCN) or by complete revision.�

This document is under the control of the EDF Configuration Control Board (CCB).�

Any questions should be addressed to:�

Data Management Office�
The ECS Project Office�
Raytheon Systems Company�
1616 McCormick Dr.�
Upper Marlboro, MD 20774-5301�
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Abstract


This document describes the human-machine interface (HMI) characteristics of the tools (computer 
software configuration items) used by the ECS operations staff. 

Keywords:  Computer Software Configuration Items (CSCIs), GUI, Interface, Operations, 
Release 5B, Screens, Software, Tools 
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1. Introduction 

1.1 Identification 

The Release 5B Operations Tools Manual, Contract Data Requirements List (CDRL) item 116, 
whose requirements are specified in the revised Data Item Description (DID) 609/OP1, is a 
required deliverable under contract NAS5-60000. 

1.2 Purpose 

This document describes the human-machine interface (HMI) characteristics of the tools 
(configuration items) that will be used by the ECS operations staff when performing the following: 

• computer systems administration 

• system monitoring 

• configuration management 

• security and accountability 

• science software integration and testing 

• resource planning�

• production planning and processing�

• science data ingest, archive and distribution�

• user services�

• common services 

This document provides background information that is the basis for the Release 5B Operations 
Procedures for the ECS Project (DID 611/OP3). The 609 document is intended to (1) familiarize 
the ECS operators with their tools, (2) be used as a reference for all ECS operational tasks, and (3) 
be used as an aid during training of ECS operations staff. 

1.3 Scope 

This document applies to Release 5B, and not to any subsequent releases of the ECS. This 
document is limited to (1) a detailed description of customized operator tools, (2) a brief 
description of COTS software used by operations and references to the applicable vendor manuals, 
and (3) a detailed description of customized Commercial Off-the-Shelf (COTS) software. This 
document will point to DID 611 for all operational procedures or to individual COTS manuals for 
detailed COTS instructions. It is intended for use by operators and maintainers of the ECS system 
during the period in which Release 5B is used. 
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1.4 Status and Schedule 

This submittal of DID 609/OP1 meets the milestone specified in the Contract Data Requirements 
List (CDRL) of NASA contract NAS5-60000. 

This document reflects the February 14, 1996 Technical Baseline (210-TP-001-006) submitted via 
contract correspondence No. ECS 194-00343. 

1.5 Organization 

This document is organized to describe the tools used by ECS operations staff during Release 5B. 

Section 1.0 provides information regarding the identification, scope, purpose, status, and 
organization of this document. 

Section 2.0 provides a listing of related documents, which were used as source information for this 
document. The section also identifies the documentation provided for each Release 5B software 
component. 

Section 3.0 provides a brief overview of the Release 5B ECS. 

Section 4.0 This section provides a detailed description of Release 5B operations tools. It is 
organized by operation function and provides the following types of information: tools overview, 
required operating environment, CSCI function, operator commands, system messages, reports, 
and outputs. 

Appendix A provides a description of Release 5B system status and error messages, including 
probable causes, impacts, and proposed actions. 

The Abbreviations and Acronyms section contains an alphabetical list of the abbreviations and 
acronyms used in Release 5B. 

The Glossary section contains terms used in this document. 
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2. Related Documentation 

2.1 Parent Documents 

The parent document is the document from which the scope and content of this Release 5B 
Operations Tools Manual has been derived. 

423-41-02° Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System (ECS) 

423-41-03 EOSDIS Core System Contract Data Requirements Document 

2.2 Applicable Documents 

The following documents are referenced within this Release 5B Operations Tools Manual, are 
directly applicable, or contain policies or other directive matters that are binding upon the content of 
this volume. 

102-CD-002° Maintenance and Operations Configuration Management Plan for the 
ECS Project 

205-CD-002° Science User's Guide and Operations Procedure Handbook, Volume 4: 
Software Developer's Guide to Preparation, Delivery, Integration and 
Test with ECS 

205-CD-004° Science User's Guide and Operations Procedures Handbook (Release 
B.0) for the ECS Project 

194-207-SE1 System Design Specification for the ECS Project 

304-CD-003° Communications and System Management Segment (CSMS) 
Requirements Specification for the ECS Project 

305-CD-510 Segment/Design Specification for the ECS Project 

307-CD-002° Science Data Processing Segment Release and Development Plan for the 
ECS Project 

311-CD-101° Data Distribution Database Design and Schema Specifications for the 
ECS Project (Draft) 

311-CD-500° Data Management Database Design and Schema Specifications for the 
ECS Project 

311-CD-502° Interoperability Subsystem (IOS) Database Design and Schema 
Specifications for the ECS Project 
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311-CD-105° Management Support Subsystem Database Design and Schema 
Specifications for the ECS Project (Draft) 

311-CD-503° Planning and Data Processing Subsystem Database Design and Database 
Schema Specifications for the ECS Project 

311-CD-504° Science Data Server Database Design and Schema Specifications for the 
ECS Project 

311-CD-505° Storage Management Database Design and Schema Specifications for 
the ECS Project 

311-CD-506° Subscription Server Database Design and Schema Specifications for the 
ECS Project 

601-CD-001 Maintenance and Operations Management Plan for the ECS Project 

604-CD-002 ECS Operations Concept for the ECS Project: Part 2B - ECS Release B 

605-CD-002 Release-B SDPS/CSMS Operations Scenarios for the ECS Project 

609-CD-001° Interim Release One (Ir1) Maintenance and Operator's Procedures for 
the ECS Project 

611-CD-004° Mission Operation Procedures - Ver. 2, Rel. 2.0, Drop 4.0 for the ECS 
Project 

613-CD-003 Release B COTS Maintenance Plan for the ECS Project 

625-CD-501 ECS Project Training Material Volume 1: Course Outline 

625-CD-520° ECS Project Training Material Volume 2: Introduction and System 
Overview 

625-CD-503 ECS Project Training Material Volume 3: Problem Management 

625-CD-504 ECS Project Training Material Volume 4: System Administration 

625-CD-505 ECS Training Material Volume 5: Network Administration 

625-CD-506° ECS Project Training Material Volume 6: Production Planning and 
Processing 

625-CD-507 ECS Project Training Material Volume 7: Resource Planning 

625-CD-508 ECS Project Training Material Volume 8: Ingest 

625-CD-509 ECS Project Training Material Volume 9: Data Distribution 

625-CD-510 ECS Project Training Material Volume 10: Archive Processing 

625-CD-511 ECS Project Training Material Volume 11: Database Administration 

625-CD-512 ECS Project Training Material Volume 12: Configuration Management 
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625-CD-513 ECS Project Training Material Volume 13: User Services 

625-CD-516 ECS Project Training Material Volume 16: Science Software Integration 
and Test 

625-CD-517 ECS Training Material Volume 17: System Troubleshooting 

420-TP-007 Planning Workbench Detailed Design for the ECS Project 

IMSV0-OP-GD-001° EOSDIS Information Management System, Users Manual for Release 
6.0 of the V0 IMS (April 1996), Hughes STX Corp., Upper Marlboro, 
MD 

IMSV0-PD-SD-002° EOSDIS Information Management System, Messages and Development 
Data Dictionary, V0 and Release A Message Passing Protocol (1995), 
Hughes STX Corp. Upper Marlboro, MD 

2.3 Information Documents 

The following documents are referenced herein, and amplify or clarify the information presented in 
this document. These documents are not binding on the content of the Release 5B Operations Tools 
Manual. 

Action Request System 2.0, Troubleshooting and Error Messages Guide (1995), Remedy 
Corporation, Mountain View, CA 

Action Request System 2.0, User’s Guide for OSF/Motif (1995), Remedy Corporation, Mountain 
View, CA 

AIX Version 4.1 iFOR/LS System Management Guide First Edition (1994), Gradient Technology 
Inc, 11400 Burnet Rd., Austin Tx 78758-3493 

AIX Version 4.1 iFOR/LS Tips and Techniques First Edition (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin Tx 78758-3493 

AMASS Overview Version 4.9(1997), EMASS Inc, 10949 East Peakview Ave., Englewood, CO 
80111 

AutoSys User Manual, Version 3.2, August 1995, AutoSystems Development Lab, PLATINUM 
Technology, Inc., Boulder, CO 

AutoXpert User Guide, Unix BETA Version 1.0, July 1995, AutoSystems Development Lab, 
PLATINUM Technology, Inc., Boulder, CO 

C Language Reference Manual (1995), Silicon Graphics, Inc., Mountain View, CA 

ProDev Workshop Environment Guide (1994), Silicon Graphics, Inc., Mountain View, CA 
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ProDev Workshop User’s Guide Volume I:  The Debugger, Build Manager, and Static Analyzer 
(1994), Silicon Graphics, Inc., Mountain View, CA 

ProDev Workshop WorkShop User’s Guide Volume II: The Performance Analyzer and Tester 
(1994), Silicon Graphics, Inc., Mountain View, CA 

ClearCase Administrator’s Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria 
Software Inc., Natick, MA 

ClearCase Quick Reference Manual, Unix Edition Release 2.0 and later (1995), 4000-013-B, Atria 
Software Inc., Natick, MA 

ClearCase User’s Manual, Unix Edition Release 2.0.2 and later (1995), 4000-011-B, Atria 
Software Inc., Natick, MA 

DCE Cell Manager 1.6.2 Overview and User’s Guide (1997), Chisholm Technologies Inc, 6805 
Capital of Texas Hwy, Austin Tx 78731 

Displaying Information and Generating Reports (iFOR/LS) (1994), Gradient Technology Inc, 
11400 Burnet Rd., Austin Tx 78758-3493 

Errors and Corrective Action (AMASS) Version 4.9 (1997), EMASS Inc, 10949 East Peakview 
Ave., Englewood, CO 80111 

Enterprise SQL Server Manager User’s Guide, Release 10.0.2 (1995), Sybase, Inc. Emeryville, 
CA 

Expert Analyzer Output File Format (1995), Network General Corporation, Menlo Park, CA 

Expert Sniffer Network Analyzer Operations (1995), Network General Corporation, Menlo Park, 
CA 

FDDI Overview and Guide to Troubleshooting (1995), Network General Corporation, Menlo 
Park, CA 

Fortran 77, Language Reference Manual (1991), Silicon Graphics, Inc., Mountain View, CA 

HP OpenView Using Network Node Manager, 1995, 3404 E. Harmony Rd., Ft. Collins CO 
80525 

HP OpenView, Network Node Manager Products, Installation Guide, 1995, 3404 E. Harmony 
Rd., Ft. Collins CO 80525 

IDL Reference Guide, Interactive Data Language (1991), Volumes 1 and 2, Version 4.0, Research 
Systems, Inc., Boulder CO 
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IDL User’s Guide, Interactive Data Language (1995), Version 4.0, Research Systems, Inc., 
Boulder CO 

iFOR/LS Administrator’s Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Installation Notes (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Quick Start Guide (1994), Gradient Technology Inc, 11400 Burnet Rd., Austin Tx 
78758-3493 

iFOR/LS Quick Start Guide, Hewlett-Packard Version (1994), Gradient Technology Inc, 11400 
Burnet Rd., Austin Tx 78758-3493 

Illustra Installation and System Administration Guide (1995), Illustra Server Rel. 3.2, Illustra 
Information Technologies, Inc., Oakland, CA 

Illustra User’s Guide (1995), Illustra Server Rel. 3.2, Illustra Information Technologies, Inc., 
Oakland, CA 

Intelligent Query and IQ Access User’s Guide for Windows and Motif, Version 5 (1996), IQ 
Software Corporation, Norcross, Georgia 

Introduction to SPARCworks, SunPro (1992), Sun Microsystems, Inc. Mountain View, CA 

Installing and Configuring Amass Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

IQ Installation Guide for Unix Motif (1995), IQ Software Corporation, Norcross, Georgia 

IQ System Manager’s Guide, Versions 3, 4, & 5 (1995), IQ Software Corporation, Norcross, 
Georgia 

IRIX Networker Administrator’s Guide, Silicon Graphics Computer Systems (1995), 007-1458­
030, Mountain View, CA 

IRIX Networker User’s Guide, Silicon Graphics Computer Systems (1995), 007-1458-030, 
Mountain View, CA 

Managing the AMASS File System Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

Microsoft Excel User’s Guide, Version 5 (1993-94), Microsoft Corporation 

Microsoft PowerPoint User’s Guide, Version 4.0 (1994), Microsoft Corporation 
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Microsoft Word, Version 6.0 (1993-94), Microsoft Corporation 

MIPSpro Fortran 77 Language Reference Manual (1994), Silicon Graphics, Inc. Mountain View, 
CA 

Netscape Navigator Handbook (Version 3.0), S. Kronick, Netscape Communications 
Corporation, Mountain View, CA 

NetWorker Administrator’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA 
94304 

NetWorker User’s Guide (1996), Legatto Systems, Inc., 3145 Porter Dr., Palo Alto CA 94304 

Network/Communications Management, Volume 1, MT923 Physical Network Management 
(1995), Accugraph Corporation, El Paso, TX 

Open Client DB-Library/C Reference Manual (1993)  , Sybase Inc., 6475 Christie Avenue, 
Emeryville, CA 94608 

Open Client and Open Server Common Libraries Reference Manual (1993), Sybase 
Inc., 6475 Christie Avenue, Emeryville, CA 94608 

PureDDTS Administrator's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA 

PureDDTS Manual Pages Reference Guide, version 3.2, Pure Software Inc., Sunnyvale, CA 

PureDDTS User's Manual, version 3.2, Pure Software Inc., Sunnyvale, CA 

Replication Server Administration Guide (1995), Sybase, Inc., Emeryville, CA 

Replication Server Commands Reference (1995), Sybase, Inc., Emeryville, CA 

Replication Server Installation Guide (1995), Sybase, Inc., Emeryville, CA 

Replication Server Troubleshooting Guide (1995), Sybase, Inc., Emeryville, CA 

Sniffer Network Analyzer: Ethernet Monitor Operations (1995), Network General Corporation, 
Menlo Park, CA 

Sniffer Network Analyzer: FDDI Monitor Operations (1995), Network General Corporation, 
Menlo Park, CA 

SQL Server Error Message, (1995), Sybase, Inc., Emeryville, CA 

SQL Server Troubleshooting Guide, (1994), Sybase, Inc., Emeryville, CA 

SQL Server Utility Programs for UNIX, (1994), Sybase, Inc., Emeryville, CA 
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SQR3 Workbench, SQR User’s Guide (1995), version 3, MITI, Long Beach CA�

The SQL Server Installation Guide, (1994), Sybase, Inc., Emeryville, CA�

StdRef Chapter 12: Object Description Language (ODL) Specification and Usage,

http://pds.jpl.nasa.gov/stdref/chap12.htm 

SYBASE SQL Server Error Messages, Releases 4.2-10.0.2, (1995), Sybase, Inc., Emeryville, 
CA 

SYBASE SQL Server System Administration Guide (1994), Sybase, Inc, Emeryville, CA 

SYBASE SQL Server Troubleshooting Guide (1994), Sybase, Inc, Emeryville, CA 

Sybase SQL Server Reference Manual Vol. 1 and Vol. , (1994), Sybase, Inc., Emeryville, CA 

System Administration Guide for SQL Server (1994), Sybase, Inc, Emeryville, CA 

System Administration Guide Supplement (operating-system specific system administration tasks) 
(1994), Sybase, Inc, Emeryville, CA 

Tivoli Enterprise Console Event Adapter Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Enterprise Console User’s Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Host Management Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli Management Platform User’s Guide (Release 2.5) , (1995), Tivoli Systems Inc., Austin, 
TX 

Tivoli/Sentry Monitoring Collection Reference Manuals, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli/Sentry User’s Guide, (1995), Tivoli Systems Inc., Austin, TX 

Tivoli User and Group Management Guide, (1995), Tivoli Systems Inc., Austin, TX 

UNIFY Developer's Reference (1989), UNIFY Corporation, Sacramento, CA 

UNIFY Direct HLI Programmer's Manual (1989), UNIFY Corporation, Sacramento, CA 

UNIX in a Nutshell, A Desktop Quick Reference, System V Edition (1994). Gilly, D. and staff of 
O'Reilly & Associates, Inc., O'Reilly & Associates, Inc., Sebastopol, CA 

Using the AMASS GUI Version 4.9 (1997), EMASS Inc, 10949 East Peakview Ave., 
Englewood, CO 80111 

XRP-II Datalook/Datarite Reference Manual (1995), HTG, Ft. Worth TX 
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XRP-II Product Information Manual (1995), HTG, Ft. Worth TX 

XRP-II System Reference Manual (1995), HTG, Ft. Worth TX 

XRP-II Tools, Techniques, and Conventions Manual (1995), HTG, Ft. Worth TX 

VolServ Graphical User Interface Guide (1995), VolServ, version 2.3, EMASS, Englewood, CO 

Wabi User’s Guide (1993), Sun Microsystems, Inc., Mountain View, CA 

Z-Mail for Motif Installation Guide, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail for Motif Reference Manual, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail for Motif User’s Guide, Version 3.2 (1994), Z-Code Software/NCD Software 
Corporation, Novato, CA 

Z-Mail Network License Server Installation and Maintenance Guide (1994), Version 1.8, Z-Code 
Software/NCE Corporation, Novato, CA 
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3. Release 5B Overview 

3.1 Release 5B Objectives 

3.1.1 ECS Mission Support Baseline 

The Release 5B ECS system supports the Landsat-7, AM-1, and Meteor SAGE III missions, as 
shown in Table 3.1.1-1 below. Release 5B also supports the Data Assimilation Office (DAO) at the 
GSFC DAAC. 

Release 5B is designed to assure successful transition to support future releases. Subsequent 
releases will support future EOS missions, such as EOS PM-1, and will incorporate evolutionary 
changes such as new processing and storage technologies, new distributed computing 
infrastructure, and expanded data metaphors and services. Successive releases will provide 
expanded and increasingly enhanced data search and access, based on feedback from the science 
community. 

Table 3.1.1-1. Mission Baseline 
Missions Instruments Launch Date 

Landsat-7 ETM+ March 1999 

EOS AM-1 ASTER, CERES, MISR, MODIS, 
MOPITT 

July 1999 

Meteor SAGE III July 1999 

3.1.2 Release 5B Capabilities 

The Earth Observing System (EOS) Data and Information System (EOSDIS) Core System (ECS) 
capabilities are developed in terms of formal releases. Release 5B, the next formal release, 
provides capabilities that are designed to support the Landsat-7, AM-1, and Meteor SAGE III 
missions. 

Release 5B is deployed at four locations, i.e.,SMC, and DAACs at GSFC, EDC and LaRC. 

A more detailed overview of the Release 5B ECS may be found in the Release 5B Segment/Design 
Specifications for the ECS Project, 305-CD-500-001. 
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4. Description of the ECS Operational Tools 

The human-machine interface (HMI) characteristics description of the software tools that the 
ECS operator uses to perform routine ECS operations is listed by the following major functional 
areas: 

4.1 Computer Systems Administration 

4.2 System Monitoring (Problem, Fault, and Performance Management) 

4.3 Configuration Management 

4.4 Security and Accountability 

4.5 Science Software Integration and Testing 

4.6 ECS Data Ingest 

4.7 Resource Planning 

4.8 Production Planning 

4.9 Production Processing 

4.10 Science Data Archive and Distribution 

4.11 User Services 

4.12 Common Services 

When using this document, the reader should note the following: 

•	 The screens/GUIs presented in this section are samples and often do not reflect the actual 
window contents seen by the DAAC operator because they depend on hardware 
configuration, actual server names, directories, etc. 

•	 Basic Unix, Network and application configuration and utilities are not explicitly 
addressed in this document. 

•	 Except for those programs that are not Motif programs and require an ASCII interface, 
launching tools from the command line is avoided as much as possible to give operations 
management the ability to control (a) access to the Unix command line and shell; and (b) 
reduce the use of the xterm. 

•	 Release 5B directory structure is discussed in DID 612, which is the Programmer's 
Manual for each of the Release 5B DAACs and the SMC. 

•	 This document references the ECS Baseline Information System web page, URL 
http://cmdm.east.hitc.com/, in several places for information on the Required Operating 
Environment. This web page is currently being constructed for the desired information in 
the ECS Baseline. Until it is put in place, the reader is referred to the DAAC library for 
hard copies of the desired COTS documents. 
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4.1 Computer Systems Administration


This section describes the computer system administration tools used by DAAC operators: 

1. Legatto’s Networker�

2. DBVision�

3. AMASS�

4. ISQL�

5. SQR Report Writer�

6. Intelligent Query and IQ Access�

7. Sybase Replication Server�

8. Global Change Master Directory (GCMD)�

9. MIB Browser�

10. Mode Manager�

11. ECS Assist�

12. ECS Registry GUI�
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4.1.1 Legatto NetWorker 

The Legatto Networker COTS Version 5.5 installed in ECS Release 5A has been verified to be 
Y2K compliant. 

Legatto’s NetWorker is a set of three components -Administration, Backup, and Recovery - used 
by system administrators to back up the entire system, with the exception of DBMS files (see 
Section 4.1.5, “ISQL”, for details on backup of DBMS files). The basic configuration is to have a 
NetWorker Server with a backup device (i.e., Jukeboxes or 8mm tapes) networked to a number of 
clients which represent the subsystem hosts. 

Site-wide system backup is performed by NetWorker. It provides a suite of integrated tools for 
backup and recovery, archive and retrieval, and hierarchical storage management. The product 
supports multi-platform networks, contains a motif-based GUI with on-line help, and supports 
concurrent device support for parallel backup and recovery using up to 16 storage devices. Both 
scheduled and ad-hoc backups, recoveries and other data management services can be performed 
by authorized users. NetWorker software consists of two components: a client portion, which runs 
on the systems to be backed up, and a server portion, which is the system to which the backup 
devices are connected. The client portion sends the data to be backed up to the server portion which 
then writes the data out to disk. 

NetWorker is used to perform the operator functions listed in Table 4.1.1-1. 

Table 4.1.1-1. Common ECS Operator Functions Performed with 
NetWorker 

Operating 
Function 

GUI Description When and Why to Use 

manage, configure, 
and monitor 
NetWorker 

• NetWorker 
Administrator 
GUI 

allows monitoring of server 
status, devices, sessions, 
messages, and pending 
displays 

to start NetWorker tasks and 
monitor server activity 

monitor and 
schedule backup 

• NW Backup 
GUI 

• group backup 
• scheduled backup 
• incremental backup 

to back up client files 

recovering backed 
up files 

• NW Recover 
GUI 

retrieves files that have been 
backed up 

to recover backed up client 
files 

4.1.1.1 Quick Start Using NetWorker 

This section presents an orientation of NetWorker. For more information, see the NetWorker 
User’s Guide, and the NetWorker Administrator’s Guide, Using NetWorker Windows and 
Menus. 

The documentation used is for version 5.5 of NetWorker. 
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4.1.1.1.1 Invoking NetWorker From the Command Line Interface 

The NetWorker Administrator tool is used to manage and configure the NetWorker environment. 
To execute NetWorker Administrator from the command line prompt use: 

nwadmin <-s server_name> & 

The NetWorker Backup tool is used to backup files on client machines. To execute NetWorker 
Backup from the command line prompt use: 

nwbackup <-s server_name> & 

The NetWorker Recover tool is used to recover files on client machines. To execute NetWorker 
Recover from the command line prompt use: 

nwrecover <-s server_name> & 

Note: The optional <-s server_name> is used only in NetWorker environments that have multiple 
NetWorker servers. 

4.1.1.2 NetWorker Main Screen 

Figure 4.1.1-1 shows the nwadmin screen. For more information on the NetWorker 
Administrator, see the NetWorker Administrator’s Guide. 
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Figure 4.1.1-1. NetWorker Administrator’s Screen 

Figure 4.1.1-2 shows the nwbackup screen. For more information on NetWorker Backup, see the 
NetWorker User’s Guide. 
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Figure 4.1.1-2. NetWorker Backup Screen 

Figure 4.1.1-3 shows the nwrecover screen. For more information on NetWorker Recover, see the 
NetWorker User’s Guide. 
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Figure 4.1.1-3. NetWorker Recover Window 

4.1.1.3 Required Operating Environment 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for Legatto Networker, refer to the ECS 
Baseline Information System web page, URL http://cmdm.east.hitc.com/. 
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4.1.1.4 Databases 

The $Installed_dir/nsr/index directory maintains a database of files that have been backed up and 
the availability of the backup such as tape number and whether it is online or on a volume of tapes 
that has been migrated. This information is in a proprietary format that can only be read using the 
nwrecover tool. 

4.1.1.5 Special Constraints 

None. 

4.1.1.6 Outputs 

NetWorker provides the capability to print and save contents of a window as a way to maintain 
records of NetWorker activities and configurations. For more information, see Chapter 3, Using 
NetWorker Windows and Menus, NetWorker Administrator’s Guide. 

4.1.1.7 Event and Error Messages 

See Appendix A: Error Messages, NetWorker’s User’s Guide, and Appendix A: Troubleshooting, 
NetWorker Administrator’s Guide. 

4.1.1.8 Reports 

None. 
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4.1.2 DBVision (Future Release) 

TBS 

Note, this is a placeholder for the above tool that will be included in future releases. This tool will 
also accommodate minor functions of SQL Monitor. 
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4.1.3 AMASS 

AMASS is a file storage management system (FSMS) for the UNIX operating system. The 
purpose of AMASS in the EOSDIS Core System (ECS) is to provide an easy-to-use interface to 
large media archives. Media is defined as tape and or optical drives. In terms of hardware, the 
FSMS host in the ECS architecture is a Silicon Graphics Inc. (SGI) Challenge XL. There are two 
main types of media libraries in ECS: 

• StorageTek (STK) Powderhorn using Redwood D3 50GB tapes 

• EMASS AML using IBM 3590 10GB tapes and/or HP 2600 2.6GB optical drives 

STK Powderhorns are used at GSFC, LaRC, NSIDC and EDC. Powderhorns support only tape 
media. Powderhorns consist of 6 major parts, the ACSLS (Automated Console System for Library 
Services) which is a Sun Sparc 5 front end controller, the ACS (Automated Cartridge System), 
CAP (Cartridge Access Port) where tape media are inserted and ejected, the LMU (Library 
Management Unit) interface unit, LCU (Library Control Unit) to control the robot, CTU 
(Controller/Transport Unit ) racks which hold up to 4 D-3 tape drives and the LSM (Library 
Storage Module) which includes the robot arms and the tape silo itself. The LSM includes a camera 
to display operation to the operator and the tape drives. Note that ACSLS is connected to the 
network via Ethernet. 

EMASS AMLs are used at the GSFC and EDC DAACs. AMLs support tape and optical media 
simultaneously. The AML (Automated Media Library) consists of four major parts, the AMU 
(Automated Management Unit) which is an IBM OS/2 microcomputer controller for the AML, the 
Entry Interface Facility (EIF) where media can be inserted or ejected from the AML, the tower 
which is a multilevel turntable that stores the media, the tape and/or optical drives and the robot(s) 
which take the media from the tower to a tape drive (which is called a mount) and from the tape 
drive to the tower (which is called a keep). Note that the AMU is connected to the network via 
FDDI. 

Many ECS AMLs will be running two ‘logical’ jukeboxes because both tape and optical drives will 
be included. This does not change the operation of the system but the operator must be aware to 
use commands going to the correct jukebox. By convention, juke 1 has the tape drives and juke 2 
has the optical drives. 

The software components are more complicated. AMASS itself is the part that the user-of-the­
system actually uses. AMASS appears to the user as just another UNIX mount point and to and 
from which one copies, moves or deletes files using standard POSIX dd, mv or rm commands. An 
operator may view the contents of the archive, monitor the system, or setup new tapes for use 
through standard commands found in the Managing the AMASS File System (Version 4.9). As of 
AMASS Version 4.7.1 the volserv program has been replaced by a client/server system called DAS 
(Distributed Archive Server) 1.3 on the AMLs and ACSLS on the STKs. DAS is the ‘glueware’ 
program that acts as a network transport for AMASS to communicate directly with the AMU 
controller software and is loaded on the AMU. Once DAS has been configured correctly, it should 
only need to be monitored unless there is a change to the hardware or for a software upgrade. 
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ACSLS combines the functionality of DAS and the AMU software in a single package. Once it has 
been configured correctly it should only need to be monitored unless there is a change to the 
hardware or for a software upgrade. Telnet is configured on both AMUs and ACSLSs. Lastly, 
there is a component that also runs on the SGI but it has no user configurable parts. 

AMASS is installed on an SGI. Control information is communicated from the SGI to the AMU 
using TCP/IP protocols via FDDI. Figure 4.1.3-1 shows the basic route that control information 
takes in sending a file to AMASS to an AML or Powderhorn: 
1. User/application initiates file transfer to AMASS 

2. AMASS receives the file over the network via ftp, dd or cp or locally via dd or cp to amass 
cache 

3. AMASS sends information over the network to the AMU/ACSLS about what tape to load 
and where to load it. 

4a.° On an EMASS silo, the AMU rotates the tower to the correct position, sends the robot to 
retrieve the tape, robot grips and retrieves the media and inserts it into the tape/optical drive 
to complete the mount. 

4b.° On an STK silo, ACSLS moves the arm to the media, the hand grips and retrieves the tape 
and inserts it into the tape drive to complete the mount. 

AMASS 

FDDI 
LAN 

SGI 

RS232 

nfs/ftp 
1 

2 3 

4 5 

User Command on AMU/ Robotics 
remote host ACSLS 

AML/STK 

Figure 4.1.3-1. Control Path 

The data path is much simpler. A SCSI controller on the SGI is directly connected to the SCSI port 
on the tape drive. Ideally, each drive gets its own controller. After the above process takes place, 
AMASS writes the file to the tape in a very simple block by block method. Note that the format of 
the tape is proprietary and NOT compatible with CPIO or TAR. 

AMASS uses both a command line and a GUI program called aawin to perform the system 
administration/operator functions listed in Table 4.1.3-1. 
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Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS 
(1 of 2) 

Operating 
Function 

Command or GUI Description When and Why to Use 

activate or 
deactivate the 
AMASS file 
system 

amassstat 
aawin GUI 

displays or toggles the 
status of AMASS 
(ACTIVE/INACTIVE) 

used to inactivate the file­
system for maintenance 
and/or to reactivate it 

add a volume volnew 
aawin GUI 

introduces a new volume to 
AMASS and assigns a 
volume number 

to add storage space for data 

add space to a 
volume group 

volnew 
volgroup 
aawin GUI 

adds additional volumes to 
an existing volume group 

when more space is required 
in an existing volume group 

create a space 
pool 

volnew 
aawin GUI 

one or more volumes 
assigned to a special 
volume group of ìSPî 

to allow AMASS to 
automatically add space 
(volumes) to a volume group 
that has run out of space 

create a 
volume group 

volgroup 
setvolgrp 
aawin GUI 

partitions the volumes in 
AMASS 

to assign volumes for specific 
purposes within AMASS 

delete a 
volume 

volstat 
voldelete 
aawin GUI 

removes a volume and its 
files from the archive 

to delete a volume and any 
files it contains 

generate a 
report 

amassreport generates standard or user 
defined report and/or raw 
output 

to extract information about 
files and directories from the 
AMASS index 

back up the 
AMASS index 

amassbackup performs full or partial back 
up of the AMASS index 

any time that the system 
needs to be backed up other 
than what AMASSs 
automatic backup provides 

put a drive into 
service 

drivelist 
drivestat 
aawin GUI 

displays the current status 
of the drives and to change 
the status 

when an INACTIVE drive is 
ready to return to service 

recover dead 
space 

volspace 
volcomp 
volformat 
aawin GUI 

compresses a selected 
volume 

to recover dead space on 
volumes 

reinitialize the 
AMASS index 

refer to the vendor 
documentation for 
the command and 
procedure 

clears out the existing index 
and reinitializes it to an 
empty index 

only when AMASS is not 
running 
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Table 4.1.3-1. Common ECS Operator Functions Performed with AMASS 
(2 of 2) 

Operating 
Function 

Command or GUI Description When and Why to Use 

reintroduce an 
offline volume 

vollist 
volslot 
bulkinlet 

volloc 

reintroduces an offline 
volume to a jukebox 

if data from an offline volume 
needs to referenced for read 
access 

remove a 
volume or 
volume group 

vollist, voloutlet, 
volloc 
aawin GUI 

removes a volume or an 
entire volume group from 
the jukebox 

to make room for new 
volumes or because data not 
being used needs to be 
retained 

remove space 
from a volume 
group 

vgroot #VG 
setvolgrp /path #VG 
volgroup 

removes space from one 
volume group to add it to 
another 

when space is needed in 
another volume group 

replace a full 
backup 
volume 

voloutlet 1, 
bulkinlet 0, 
vollabel {to rename} 
tapelength 1 2 
volformat -b 256k 1 
amassbackup -fv 

initializes a new backup 
volume and performs a full 
backup 

when the backup volume is 
95% full 

restore the 
AMASS 
database 

amassrestore restores the index either 
completely or to the point of 
the last full or partial backup 

when the index is corrupt on 
the magnetic disk 
do not use the amassrestore 
command when AMASS is 
running 

retrieve 
system usage 
by user 

amassreport displays the number of files 
and directories owned by a 
user and the amount of 
space they take up 

to get statistical information 
on the amount of space used 
by an individual(s) 

retrieve 
system usage 
by volume 

adf displays volume group, 
jukebox reference number, 
position of volume, amount 
of used space, number of 
directories and files on 
volume, amount of free and 
dead space 

to get statistical information 
about the usage of a 
particular volume 

reuse a 
volume 

(volcomp, volstat, 
volclean, volformat 
aawin GUI 

compresses and moves 
existing data to another 
volume, then reformats the 
volume 

when a volume contains data 
no longer needed or 
contains mostly dead space 

take a drive 
out of service 

drivelist, drivestat 
aawin GUI 

displays and changes the 
status of the drive 

when a drive has excessive 
failures or for maintenance 
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4.1.3.1 Quick Start Using AMASS 

For more information about AMASS, refer to the Managing the AMASS File System and Using 
The AMASS GUI guides. 

The documentation of AMASS used as a basis and referenced in this section is for AMASS 
4.9.1.1 

4.1.3.1.1 Invoking AMASS From the Command Line Interface 

AMASS is normally started at boot and shutdown when the system is shutdown using scripts in 
the /etc/rc2.d and /etc/rc0.d directories that are linked to the actual scripts in /etc/init.d. AMASS can 
also be started and stopped from the command line. 
To execute AMASS from the command line prompt use: 

/usr/amass/tools/amass_start 

To stop AMASS, type: 

t1drg01 100> /usr/amass/tools/killdaemons 

AMASS startup at boot can be enabled or disabled using the amass_atboot command. For 
more information on accessing AMASS via the command line, refer to Chapter 3, Command 
Reference, Managing the AMASS File System. 

The AMASSADMIN GUI can be started from the command line by typing 

/usr/amass/bin/aawin 

For more information on running the AMASS, refer to Using The AMASS GUI guide. 

For a description of AMASS commands and the functions they perform, see Chapter 2, 
Operational Tasks, and Chapter 3 , Commands of the Managing the AMASS File System. 

4.1.3.2 AMASS Main Screen 

AMASS allows the operator to perform a subset of the command line functions, as well as query 
online index and output results to a file for further processing. For more information on the 
AMASS, refer to Using the AMASS GUI guide. 

The window area of the AMASS Main Screen shown in Figure 4.1.3-2 is referred to as ‘The 
Workroom’. 
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Figure 4.1.3-2. AMASS Main Screen (AAWIN) 

AAWIN Pulldown Menu options: 

File 

Exit:  Exits AMASS. 

Clear Workroom:  Clears the Workroom of all icons. 

Tasks 

Modify a Volume Group 

Modify a Volume 

Admin 

Scheduler:  Opens the Scheduler Status window. 
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Sysperf:  Opens the sysperf window displaying the status of the AMASS activity. 

Preferences 

Show/Hide Detail Windows:  These windows give a brief description of the items the 
mouse pointer is touching. 

Help:  Opens the Help Window. 

AMASS Utility Bar options (the Utility Bar is a vertical toolbar on the right side of the Main 
Screen) 

Trash Can icon 

Volume Group icon displays the volume group icons in the Workroom as shown in Figure 
4.1.3-3. 

Volume icon displays volume icons in the Workroom. 
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Figure 4.1.3-3. AMASS Main Screen showing selected volumes 
in the Workroom 

4.1.3.3 Required Operating Environment 

AMASS requires a UNIX environment. AAWIN requires an X-window server. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for AMASS, refer to the ECS Baseline 
Information System web page, URL. 

http://cmdm.east.hitc.com/. 
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4.1.3.3.1 Interfaces and Data Types 

The commands and the AMASS GUI that operations staff use to interface with AMASS are 
described in the Managing the AMASS File System and Using The AMASS GUI. 

4.1.3.4 Databases 

The File Storage Management System provided by EMASS Company includes the RAIMA 
database product. AMASS utilization of the database is transparent to the operator. 

4.1.3.5 Special Constraints 

None. 

4.1.3.6 Outputs 

Output from the AMASS consists of the data displayed on the GUI described in Section 4.1.3.2, 
database updates or additions to the database referenced in Section 4.1.3.4, error and event 
messages described in Section 4.1.3.7, and reports described in Section 4.1.3.8 which may 
produce files output in response to user actions or are printed. 

4.1.3.7 Event and Error Messages 

AMASS generates the following types of messages: 

•	 Informational (AMASS_I): Informational messages inform you about a process or 
situation. The status of AMASS is not changed when you receive an informational 
message. 

•	 Warning (AMASS_W): Warning messages inform you of situations that require 
attention but do not inhibit the functioning of AMASS. 

•	 Error (AMASS_E): Error messages require the immediate attention of the System 
Administrator to insure the proper functioning of AMASS. 

•	 System (AMASS_S): System messages indicate internal errors and should be reported 
to the EMASS Technical Assistance Center (ETAC). 

AMASS uses the standard syslogd function of the operating system for all of its warning, error 
and system messages. This facility allows the system administrator to control the output 
destination(s) of these messages. 

With the /etc/syslog.conf file, the operator can control the destination of each of the message types. 
The syslog.conf file is typically set up to log all levels of AMASS messages to var/adm/messages. 
The console is typically set up to see all AMASS levels generated by the kernel facility and the 
system and error level generated by the daemon facility. 
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For a description of AMASS event and error messages, refer to Errors and Corrective Action 
manual. 

4.1.3.8 Reports 

AMASS reports provide information of the AMASS holdings using the amassreport report 
generator. Specific reports may be tailored for specific information on the basis of selections by 
date, file, directory, errors, length, size, or IDs. All reports have the column heading listed in 
Table 4.1.3-2. 

Table 4.1.3-2. Amassreport Column Headings 
Heading Description 

Name Name of file 

Parent Record ID of Parent. 

Last Accessed Last Accessed date on timestamp. 

Mode Permission IDs. 

Size File size in megabytes 

File ID File Number. 

UID User ID 

GID Group ID 

Last Modified Date and time showing date the file was last modified. 

Vol File is located on this volume number. 

Table 4.1.3.-3 below lists two types of AMASS reports using the amassreport command. 

Table 4.1.3-3. Amassreport Report Types 
Output Description and Format 

formatted report prints a column header at the top of each page 

raw output prints data without a column header 
can be used with other utilities to generate custom reports 

The content of both types of tables is the same. The raw output type is meant to be used to provide 
input for further processing to a more complete reporting system. 

For information on using amassreport see Chapter 3, Command Reference, Managing the 
AMASS File System. 

4.1.3.8.1 Sample Report 

Below, Figure 4.1.3-4, is an example of a formatted amassreport showing volume group 20. 
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NAME FILEID PARENT UID GID LAST MODIFIED LAST ACCESSED MODE


VOL SIZE


file_create 23 2 3137 20 Oct 21 10:06 Nov 06 18:17 drwxrwxr-x


20 0


testfiles1 171147 23 435 20 Oct 22 08:57 Nov 04 06:32 drwxr-xr-x


20 0


random_files 333451 23 435 20 Sep 11 1996 Nov 04 08:04 drwxr-xr-x


20 0


portioned_random_files 1751199 23 3137 20 Sep 25 1996 Nov 04 08:04 drwxr-xr-x


20 0


logs_tape 2975809 2 435 20 Oct 22 1996 Nov 03 23:01 drwxrwxr-x


20 0


Figure 4.1.3-4. Amassreport example showing Volume Group 20 
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4.1.4 ISQL 

Interactive SQL (ISQL) is a stand-alone SQL command parser utility provided with the Sybase 
SQL Server and is available on all platforms that Sybase is available. ISQL is executed directly 
from the operating system level, and is used to interact with a SQL server and the databases on a 
SQL server. It allows for the interactive issuance and execution of Sybase Transact-SQL 
statements and sends the Transact-SQL commands to the SQL Server, formatting the results and 
printing them on the standard output. ISQL is used to perform the operator functions listed in 
Table 4.1.4-1. 

Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(1 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Monitor 
database and 
user activity 

See Chapter 1 - Overview 
of System Administration 
in the System 
Administration Guide for 
SQL Server 

There are various 
database management 
activities performed in 
Sybase SQL Server to 
keep the databases 
running for day-to-day 
operations 

Database and user activity 
is monitored to manage 
and control various day­
to-day operations of the 
DAAC and to prevent or 
resolve any unforeseen 
problems 

Provide and 
control users' 
database 
access 

• See Chapter 4-
Managing SQL Server 
Logins and Database 
Users in the System 
Administration Guide for 
SQL Server 

• See Chapter 5 -
Managing User 
Permissions in the 
System Administration 
Guide for SQL Server 

• Create user accounts, 
set account default 
databases and other 
account configurable 
items 

• Grant proper 
permissions to user 
accounts 

• It may be necessary to 
provide access to 
individual users or 
groups of users on a 
temporary, permanent, 
or on-demand basis 

• Access to data at the 
DAAC should be 
controlled so it is not 
accidentally deleted, 
modified, or obtained 
without permission 
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(2 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Grant roles 
and assign 
various 
privileges on 
database 
objects 

See Chapter 2 - Roles in 
SQL Server in the System 
Administration Guide for 
SQL Server 
Chapter 5 - Managing User 
Permissions in the System 
Administration Guide for 
SQL Server 

Roles and user accounts 
are necessary to provide 
access and security to 
databases under 
Sybase SQL Server 

• Proper database 
management roles such 
as SSO (System 
Security Officer), SA 
(System Administrator), 
OPER (Operator) are 
essential to the proper 
management of the 
databases at DAACs 

• Providing the proper 
level of privileges to 
each user of the 
databases prevents any 
accidental or 
unforeseen mishaps 
with the data (data 
integrity is also 
maintained) 

Monitor, 
control, and 
manage the 
use of disk 
space, 
memory and 
connections 

See Chapter 3 - Managing 
Physical Resources in the 
System Administration 
Guide for SQL Server 
Chapter 6 - Checking 
Database Consistency in 
the System Administration 
Guide for SQL Server 

• All databases running 
under Sybase SQL 
Server are physically 
stored on various 
devices and require 
various amounts of 
memory based on the 
usage of data 

• These resources have 
to be properly 
monitored 

• Resources for storage 
and manipulation of 
data are always at a 
premium 

• Proper management of 
these resources is 
essential in reducing 
errors, database 
crashes and unwanted 
downtime 

Backup and 
restore 
databases 

• See Chapter 7 -
Developing a Backup 
and Recovery Plan in the 
System Administration 
Guide for SQL Server 

• Chapter 8 - Backing up 
and Restoring user 
databases, in the System 
Administration Guide for 
SQL Server 

• Chapter 9 - Backing up 
and Restoring the 
system databases in the 
System Administration 
Guide for SQL Server 

Backup of databases 
provides for quick 
recovery and 
maintenance of data 
integrity 

• Most Database 
Administrators perform 
a daily backup of all their 
databases and perform 
recovery operations 
when a database 
crashes and is 
unrecoverable by other 
recovery methods 

• Proper backup and 
recovery plans allow for 
full, quick recovery and 
zero loss of data 

• Regular backup of data, 
is essential in reducing 
downtime in case of a 
database crash 
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Table 4.1.4-1. Common ECS Operator Functions Performed with ISQL 
(3 of 3) 

Operating 
Function 

Command/Script Description When and Why to 
Use  

Diagnose 
system 
problems 

• See Chapter 11 -
Diagnosing System 
Problems in the System 
Administration Guide for 
SQL Server 

• Also see the SYBASE 
SQL Server 
Troubleshooting Guide 

• Diagnosing problems 
with the operation of 
SQL Server is a regular 
part of database 
administration tasks 

• ISQL is used as a 
command line tool for 
interfacing with the 
SQL Server 

• Anytime the SQL server 
is not performing 
according to 
expectation or any 
database on SQL 
Server has crashed, the 
problem(s) must be 
diagnosed by checking 
current SQL Server 
status information 

• All problems must be 
properly resolved for 
successful operation of 
SQL Server 

Fine-tune 
SQL server 
performance 

See Chapter 12 - Fine­
tuning Performance and 
Operations in the System 
Administration Guide for 
SQL Server 

A continuous operations 
and administration 
activity that may involve 
any of the above 
activities to make sure 
SQL Server makes best 
use of its resources and 
to gain maximum 
performance from SQL 
Server 

The SQL Server is fine­
tuned whenever storage 
or data requirements 
have changed, number of 
users have changed, new 
databases are added or 
existing databases are 
deleted, any SQL Server 
settings are modified, or 
any external environment 
changes have occurred 
which may impact the 
SQL Server 
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In addition, the DAAC user community may use ISQL to: 

• request data from various databases by issuing Transact-SQL statements 
• insert, update, or delete data from various databases by issuing Transact-SQL statements 
• change their passwords 

4.1.4.1 Quick Start Using ISQL 

This section presents an orientation of ISQL. For more information on ISQL, refer to the SQL 
Server Utility Programs for UNIX. 

Other manuals that the operator may find useful are: 

• System Administration Guide for SQL Server (SQL Server administration issues) 
•	 System Administration Guide Supplement (operating-system specific system administration 

tasks) 
•	 Open Client DB-Library/C Reference Manual (man pages and code samples for the SQL 

Server interface library, Open Client DB-Library) 
• The SQL Server Installation Guide (installation procedures for SQL Server) 
• SQL Server Reference Manual Vol. 1 and Vol. 2( commands and system procedures) 

These and other Sybase manuals can be found online at the SyBooks Online Publications page at: 

http://www.sybase.com/Offerings/Sybooks/books.html 

The documentation of ISQL used as a basis and referenced in this section is for version 10.0.4 
contained in ECS Release 4. This tool is a COTS product provided by ECS. 

4.1.4.1.1 Invoking ISQL From the Command Line Interface 
To execute ISQL from the command line prompt use: 

isql 

For detailed instructions on how to invoke ISQL see Chapter 3 - Using ISQL in the SQL Server 
Utility Programs for UNIX guide. 

4.1.4.2 ISQL Main Screen 

There is no ISQL GUI. The ISQL uses the command line interface for operator communications. 

4.1.4.3 Required Operating Environment 

The utility program ISQL is invoked directly from the UNIX operating system via the command 
line. 

For all COTS packages, appropriate information on operating environments, tunable parameters, 
environment variables, and a list of vendor documentation can be found in a CM controlled 
document for each product. To find the documentation for ISQL, refer to the ECS Baseline 
Information System web page, URL http://cmdm.east.hitc.com/. 
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4.1.4.3.1 Interfaces and Data Types 

SQL Server requires an interfaces file to map logical server names to physical network information 
about those servers. The interfaces file includes server name, network address, and the port 
number on which the server listens on for queries. For detailed information on the interfaces files 
please see the Open Client/Server Supplement for your operating system. 

4.1.4.4 Databases 

For more information on Sybase SQL Server databases, refer to the SYBASE SQL Server System 
Administration Guide. 

4.1.4.5 Special Constraints 

None. 

4.1.4.6 Outputs 

Output from the ISQL consists of database updates or additions to the databases referenced in 
Section 4.1.4.4, and error and event messages referenced in Section 4.1.4.7. 

ISQL does not provide formatting options for the output, but the -n option eliminates ISQL 
prompts, while -e will include each command issued to ISQL in the output. Other tools can then be 
used to reformat the output. For further information on formatting ISQL output please see the SQL 
Server Utility Programs for UNIX manual. 

4.1.4.7 Event and Error Messages 

Sybase SQL Server issues both status and error messages from the SQL Server and ISQL formats 
them to the designated output. For details on setting output options for ISQL the SQL Server 
Utility Programs for UNIX manual. 

For more information on error messages, their cause and corrective actions, refer to the SYBASE 
SQL Server Error Messages manual. 

4.1.4.8 Reports 

None. 
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4.1.5 SQR Report Writer (Future Release)


TBS�

Note, this is a placeholder for the above tool that will be included in future releases.�

4.1.5-1 609-CD-510-002�



This page intentionally left blank. 

4.1.5-2 609-CD-510-002�



4.1.6 Intelligent Query and IQ Access (IQ) (Future Release)


TBS�

Note, this is a placeholder for the above tool that will be included in future releases.�
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4.1.7 Sybase Replication Server (Future Release)


TBS�

Note, this is a placeholder for the above tool that will be included in future releases.�
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4.1.8 Global Change Master Directory (GCMD) (Future Release)


TBS�

Note, this is a placeholder for the above tool that will be included in future releases.�
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4.1.9 MIB Browser 

The ECS Management Information Base (MIB) Browser tool provides operations personnel with 
the ability to monitor ECS applications. Figure 4.1.9-1 shows the MIB browser GUI and its 
intercommunication with host agents in the network. There is a MIB data structure associated with 
each computer in the ECS system. The MIB defines the parameters used by the ECS performance 
monitoring components to control access to information in the host computer. The GUI interface 
allows users to manage these performance variables on ECS applications. 

ECS 
Apps 1 

ECS 
Apps 2 

ECS 
Apps n 

nth apps 

.cfg 
files 

ECS MIB 
BROWSER 

GUI 

Deputy 
Agent 

Master 
Agent 

SNMP 

Sub- Agent 

ECS HOST 

RPC Event 

OPEN VIEW 

SNMP 

Figure 4.1.9-1. Representation of MIB Browser Operating Environment 

Table 4.1.9-1 summarizes the operator functions that the MIB Browser supports. 
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Table 4.1.9-1. Common ECS Operator Functions Performed with 
the ECS MIB Browser 

Operating 
Function 

Command Description When and Why to Use 

Determine 
Management 
Information 
available on ECS 
host computers 

Up Tree, Down 
Tree, Describe 

Displays the MIB 
variables defined for 
ECS hosts. 
Provides a 
description of the 
variables. 

• To identify the variables defined 
for a specific host. 

• To determine the meaning of the 
variable 

Display MIB 
variable values 

Start Query, Stop 
Query 

Displays the 
selected MIB variable 
values. 

• To view or capture the MIB variable 
values 

Display graphs of 
the Management 
Information 

Graph Generates a chart of 
the selected MIB 
variable values. 

• To provide a visualization of the 
data for analysis. 

4.1.9.1 Quickstart Using MIB Browser 

The ECS MIB Browser can not be invoked from the command line. The MIB Browser is 
activated from the HP OpenView “Misc” toolbar. Refer to section 4.2.1 for a description of how 
to bring up OpenView.. 

4.1.9.1.1 Invoking MIB Browser From Open View 

In the Open View GUI , shown in Figure 4.1.9-2, select Misc from the Desktop toolbar and 
choose MIB Browser from the displayed menu. 
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Figure 4.1.9-2. HP OpenView GUI showing Desktop bar 

4.1.9.2 The ECS MIB Browser Main Screen 

Figure 4.1.9-3 below presents the ECS MIB Browser Main screen. 
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Figure 4.1.9-3. MIB Browser GUI 
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The following options are available on the MIB Browser menu toolbar. 

File - The File menu on the ECS MIB Browser toolbar shows the following options. 

Save As - Saves the results of the ECS MIB Browser in a user specified file. 

Close - Exits the ECS MIB Browser. 

View – The View menu shows the following options: 

ChangeSelection  Allows the user to change the host. The selected ECS Host will be 
shown in the Name or IP Address field. 

Object Identifier As Text – This option allows the host object to be identified as 
Text. 

Help - Describes a specific object or an application parameter and explains its functionality. 

Table 4.1.9-2 below provides a detailed description of the fields in the ECS MIB Browser main 
screen.. 

Table 4.1.9-2. ECS MIB Browser Field Descriptions (1 of 4) 
ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

Name or IP 
Address 

GUI window Text field 
(mandatory) 
Internet Protocol 
address of the host 
that is running. 

Type the IP address in the window, or 
select the host using Change Selection in 
the View. A selected icon’s host 
information will automatically be populated 
when change selection is invoked. 

Mode GUI window Text field 
(mandatory) 
Mode id of the host 

Narrow scope; Values concerning that 
mode only. Currently not being used. 

Community Name GUI window Text field 
Password for each 
host. 

All ECS hosts are required to provide 
specific Community Name. If already 
configured in OpenView, this setting is not 
required. 
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Table 4.1.9-2. ECS MIB Browser Field Descriptions (2 of 4) 
ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

MIB Object ID GUI window Text field 
(mandatory). 
Shows the root 
directory 

To collect information on a specified 
application using the MIB Browser, the 
following must be running: 
Specified application 
Master Agent 
Sub-Agent 
Deputy Agent. 

Application 
Program 
Process 

MIB 
directory/file 
structure 
window 

Shows the structure 
of MIB directory/file 
in this window. 
Application is the 
highest level, 
followed by Program 
Level, and lastly the 
Process Level. 

Double clicking on the Application Level, 
displays the directory and file structure in 
the window. 
Highlight the Application. 
Navigate up or down in the file structure 
using the Up Tree or Down Tree buttons. 
User can start at the Application Level 
(highest level), and then navigate down to 
the Program Level (middle level) or the 
Process Level (lowest level). 
Application Level is divided into five 
categories. These are: 
1. static tables (appStTable), 
2. dynamic tables (appDyTable), 
3. performance tables (appPerfTable), 
4. fault tables (appFaultTable), 
5. configuration tables (appCfgTable). 
Program Level is divided into four 
categories, namely: 
1. progStTable, 
2. progDyTable, 
3. progFaultTable, and 
4. progCfgTable 
Process Level is divided into three 
categories, namely: 
1. procDyTable, 
2. procPerfTable, and 
3. procFaultTable 
Within each category, there are many 
parameters. For the dynamic, 
performance, and fault tables, thresholds 
and polling intervals can be set. 

Up Tree GUI button For navigating 
upwards in the 
directory and file 
structure. 

Highlight a directory or file, in the 
Application, Program or Process level in 
the MIB structure window, and then click on 
the Up Tree button to navigate upwards. 
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Table 4.1.9-2. ECS MIB Browser Field Descriptions (3 of 4) 
ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

Down Tree GUI button For navigating 
downwards in the 
directory and file 
structure. 

Highlight a directory or file, in the 
Application, Program or Process level in 
the MIB structure window, and then click on 
the Down Tree button to navigate 
downwards. 

Describe GUI button Displays the 
Describe MIB 
Variable GUI. 
This GUI displays the 
NAME of the 
application, 
OBJECT ID, TYPE 
of application, and 
DESCRIPTION of 
the application. It 
also has a Close 
button to close the 
GUI and return to 
ECS MIB Browser 
GUI. 

Once the Name or IP Address, Mode, 
Community Name and MIB Object ID fields 
within the ECS MIB Browser are filled in 
completely, then additional information 
about the specific MIB Variable can be 
attained by pressing the Describe button. 
This displays the Describe MIB Variable 
Pop-up (Figure 4.1.9-4). 

Start Query GUI button Starts the query on 
the highlighted 
application in the 
MIB directory/file 
structure window of 
the ECS MIB 
Browser GUI. 
Only one application 
can be selected at 
one time to perform 
query on. 

Highlight the application in the directory/file 
structure window. 
Click on the Start Query button. 
This will populate the MIB Values screen 
with the results of the query. 
Use scroll bars to view complete results, if 
needed. 

Stop Query GUI button Stops the query on 
an application. 

Click on the Stop Query button to stop 
query on an application. 

Graph GUI button Displays the Graph 
GUI, and shows 
query results 
graphically. 

After the results of the query are displayed 
in the MIB Values screen, click on the 
Graph button. 
Graph GUI represents the query results 
graphically. A helpful visual tool for 
checking the performance of applications. 
This displays the Graph GUI Pop-up (Figure 
4.1.9-5). 
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Table 4.1.9-2. ECS MIB Browser Field Descriptions (4 of 4) 
ECS MIB 

Browser GUI 
(main screen 

Command/ 
Script or GUI 

Description When and Why to Use 

MIB Instance GUI window Displays the current 
MIB Instance for the 
application 
parameter. 

Displays the MIB Instance for an application 
parameter. 
Can set it by typing in the MIB Instance field 
(See Set function). 

MIB Set Value GUI window Displays the current 
MIB Value for the 
application 
parameter. 

Displays the MIB Instance for an application 
parameter 
Can set it by typing in the MIB Set Value 
field (See Set function). 

MIB Values GUI window Displays the output 
of the query for a 
selected application 
within the 
Application, 
Program or Process 
Level. 

Displays the MIB Values for an application. 
To understand what these application 
parameters mean, refer to the Help menu 
or highlight the application parameter 
inside the MIB Values and click on the 
Describe button. 

4.1.9.2.1 The Describe MIB Variable Pop-up 

The Describe button on the ECS MIB Browser main screen displays the Describe MIB Variable 
Pop-up shown in Figure 4.1.9-4. This display-only pop-up provides the full description of the 
MIB Variable shown in the MIB Object ID of the main screen. 
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For a description of the fields in the ECS MIB Variable Pop-up, see Table 4.1.9-3 below.

Describe MIB Variable Pop-up



Table 4.1.9-3. Describe MIB Variable Field Descriptions 
Describe MIB 

Browser Pop-up 
GUI Description 

Name or IP Address GUI window 
(display only) 

Internet Protocol address of the host that is running. 

Object ID GUI window 
(display only) 

Unique ID of the MIB variable used for storing and 
accessing the value 

Type GUI window 
(display only) 

The SNMP protocol uses a subset of ASN.1 (Abstract 
Syntax Notation One) to define the structure of data in a 
protocol data unit (PDU). SNMP uses the simple abstract 
data type to define the information content of the PDU 
which is the packet that is exchanged between an SNMP 
manager and its agents. The data type can be one of the 
following: 
Boolean TRUE or FALSE 
Integer The set of whole numbers 
Bit String A sequence of 0 or more bits 
Octet String A sequence of 0 or more octets 
Real The set of real numbers 
Enumerated An explicit list of integer values that a data type 
can take. 
Most often the type field in the MIB Browser will be either 
Integer or Octet String. 

Description GUI window 
(display only) 

Text description of the MIB variable 

4.1.9.2.2 HP OpenView Graph Pop-up 

The Graph option of the MIB Browser is performed by HP OpenView. See Section 4.2.1.2.2 for 
more information about the Graph option. Figure 4.1.9-5 shows the Graph Pop-up window. 
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Figure 4.1.9-5. Graph Pop-up 

For a description of the Graph Pop-up, see Table 4.1.9-4 below. 

Table 4.1.9-4. Graph Field Descriptions 
Graph GUI Description 

Variables GUI window 
(display only) 

MIB variable are color coded as shown by the color of the 
variable IDs in the top portion of the Pop-up 

Horizontal Axis GUI window 
(display only) 

The selected time period 

Vertical Axis GUI window 
(display only) 

The numeric value of the MIB variable at the measuring 
point reflected in the horizontal axis. 

4.1.9.3 Required Operating Environment 

MIB Browser requires Open View running in the UNIX environment. The ECS MIB Browser 
GUI is only accessible from within the Open View. 
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For information on the operating environment, tunable parameters and environment variables of 
MIB Browser refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation 
series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC. 

4.1.9.3.1 Interfaces and Data Types 

This Tool exchanges data of various types through interfaces within and external to ECS. Table 
4.1.9-5 lists interfaces for Release 4. The MIB Browser utilizes two protocols for accessing the 
MIB. To Get variables (for monitoring performance parameters), it uses Simple Network 
Management Protocol (SNMP), and to Set variables (e.g., thresholds), it uses Distributed 
Computing Environment (DCE) Protocol. (The Set capability is not employed in the current 
release.) 

Table 4.1.9-5. Interface Protocols 
Interface Type of Primary 

Interface 
Protocols 

Type of Backup 
Interface 
Protocols 

Comments 

SNMP Inter-computer N/A Used to Get variables 

DCE intra-system N/A Used to Set variables 

4.1.9.4 Databases 

No database is associated with or used by the ECS MIB Browser. The ECS MIB Browser reads 
and compiles the ECS MIB located in the /var/opt/ov/share/snmp-mibs subdirectory on the 
HP Open View platform. This MIB is used to query the ECS hosts for data about the ECS 
applications at each host. The query identifies the data Types (see Table 4.1.9-4) to be returned 
from the host. The data values for the MIB objects are collected dynamically from the hosts by the 
agents/subagents in response to a query. The agents/subagents determine the location of the data 
values from the query and package the response based on the data Types. 

4.1.9.5 Special Constraints 

Necessary setup required to access information on any ECS Host, using ECS MIB Browser GUI: 

1. HP OpenView must be running. 

2. A Master Agent should be running in the background (e.g., EcMsAgAgent. 

3.° A Sub-Agent must be running in the background (e.g., EcMsAgSubAgent ), and should be 
linked to Master Agent and monitoring ECS Applications (Apps). 

4.° A Deputy Agent should be running in the background (e.g., EcMsAgDeputy), which will 
direct Remote Procedure Calls (RPC) from the sub-agent to the ECS MIB Browser, using 
the SNMP. (Not necessary unless SETs are employed) 

5. ECS application(s) must be running, in order to collect information. 
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The proper community string must be entered in the community Name field of the ECS MIB 
Browser GUI. This is the token or password that permits the operator to gather data from the ECS 
host. Different community values can be used to obtain privileges to all or part of the MIB. 
Operators must obtain the proper community string from the System Administration personnel. 
This may not be necessary if OpenView is configured with the proper community name by default 
in the /etc/SnmpAgentid/Snmpd.conf file. No string would then be needed. 

4.1.9.6 Outputs 
Outputs consist of the information displayed on the screens discussed in Section 4.1.9.2 and messages from stout 
and stderr which are redirected to the log file found in the /usr/ecs/shared/custom/logs subdirectory. 

4.1.9.7 Event and Error Messages 

Error messages are sent to stderr and redirected to the log file described in Section 4.1.9.6. This 
is for Deputy only; custom code messages go to stdout/err. 

4.1.9.8 Reports 

None. 
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4.1.10 Mode Manager GUI 

The Mode Manager GUI is the tool for controlling the Mode Management Service (MMS), a 
custom developed ECS service which is tightly integrated with HP OpenView (see Section 4.2.1 
HP OpenView). It allows for the configuration of ECS applications in one operational mode and a 
variety of support modes in the training and test area. The MMS incorporates the mode 
management user interface directly into the HP OpenView GUI, providing methods to activate and 
deactivate a mode. In addition, it provides a mode specific user interface for accessing CSS life­
cycle control (startup and shutdown). Monitoring capabilities are provided within HP OpenView 
and are enhanced to reflect mode specific status of software system, subsystem, application, 
program, and process level entities. Hardware is mode independent so its status is reflected within 
every mode in which it is configured. HP OpenView graphically supports multiple modes through 
the use of separate sub-maps and symbol labels. The map can have any number of sub-maps 
defined that decompose the basic high level map representation. Each mode has its mode specific 
map (and associated sub-maps) predefined to recognize and support the hardware and software 
components that are supporting the given mode. 

Table 4.1.10-1 summarizes the operator functions that the Mode Management Service supports. 

Table 4.1.10-1. Common ECS Operator Functions Performed with the 
Mode Management Service 

Operating 
Function 

Command Description When and Why to Use 

Add an Active 
Mode 

Add Adds a mode in the 
display of Available 
Modes to the Active 
Mode display and List 

When a previously not active mode is 
to be activated. 

Remove an active 
mode 

Remove Removes a mode in 
the Active Mode 
Display and List and 
restores it to the 
Available Mode 
display and List. 

When a mode is to be made inactive. 

Insert a new mode Insert Active Mode Puts a new mode in 
the Active Mode 
Display. 

When it is necessary to create a new 
active mode. 

Activate new 
mode 

Rediscover Shortcuts the 
subagent rediscovery 
process and forces 
the new mode into 
service across the 
network. 

When a new mode is placed in 
service and must be activated on all 
hosts. 

Update the 
Available Modes 
List 

Refresh Forces an update to 
the Available Modes 
List. 

When all the hosts have to be made 
aware of a new mode. 
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4.1.10.1 Quick Start Using Mode Management Service 

Mode Manager is started as part of the system start-up. It may be started from HP Openview (See 
Section 4.1.10.1.3 below). The Mode Manager operator interface consists of a single Main 
screen, the (ECS Mode Manager) and a confirmation dialog (pop-up). The ECS Mode Manager 
Main Screen is run on each ECS machine that has ECS Modes applied. 

4.1.10.1.1 Invoking Mode Management Service From the Command Line 
Interface 

The ECS Mode Management Service can not be invoked from the command line. The ECS Mode 
Manager is activated from HP Open View as described in Section 4.1.10.1.2. 

4.1.10.1.2 Invoking Mode Management Service From Open View 

From the Open View Main Screen, shown in Figure 4.1.10-1, select Misc from the Desktop bar 
and choose ECS Mode Manager from the displayed menu. 

Figure 4.1.10-1. HP OpenView Main screen showing Desktop bar 
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4.1.10.2 The ECS Mode Management Service Main screen 

Figure 4.1.10-2 presents the ECS Mode Manager Main screen. 

Figure 4.1.10-2. ECS Mode Manager Main Screen 

For a description of the Mode Management Service Toolbar, see Table 4.1.10-2 below. 
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Table 4.1.10-2. Mode Management Service Main Screen

Options and Fields


Option/Field Action Description 

File menu Click on File on the Mode 
Manager Main screen Toolbar. 

Pull down menu showing Save As and Close 
selections. 

Save As In the File menu, click on Save 
As. 

To save results of ECS Mode Manager in any 
file or directory. 

Close In the File menu, click on 
Close. 

To exit the ECS Mode Manager. 

Help menu Click on Help on the Mode 
Manager Main Screen 
Toolbar. 

Describes a specific object or an application 
parameter, and explains its functionality. 

AVAILABLE MODE field List of the available modes 
from the Available Mode List. 
(Not implemented in this 
release) 

The Available Mode List and Active Mode List 
are supplied by the Network Management 
Platform 

ADD button Adds one or more modes 
from the Available Mode List 
to the Active Mode List. 

Select (highlight) the mode(s) to be entered 
into service before clicking the Add button. 

ACTIVE MODES field List of the active modes from 
the Active Mode List. 

The Available Mode List and Active Mode List 
are supplied by the Network Management 
Platform 

REMOVE button Removes a mode(s) from the 
Active Mode List. 

Select (highlight) the mode(s) to remove from 
service before clicking the Remove button. 
The selected modes are moved to the 
AVAILABLE MODE pool. Since no mode can 
be removed from service while the mode is in 
use, an hourglass popup window is displayed 
while checking to see that no servers are 
running in that mode. If there are, a dialog box 
will indicate which servers are still running. 
Otherwise, the mode is removed. 

INSERT ACTIVE MODE 
field 

Manually put a new mode into 
service 

When an available mode is not discovered. 

REDISCOVER button Alerts all ECS hosts 
subagents that a new mode is 
entered into service. 

Forces all ECS subagents to check for a new 
mode. This will add or remove a submap 
hierarchy for the mode being added or 
removed. 

REFRESH button Update the available modes 
list. 

Forces an update of the mode label in the 
available modes list. This shortcuts the 
subagent discovery process which would 
normally provide automatic update of the list. 

CLOSE button Terminate the Mode Manager 
session. 

A dialog box (see section 4.1.1.2.1) will ask 
for confirmation from the user. 
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4.1.10.2.1 The Mode Manager Question Dialog 

The Mode Manager Question Dialog shown in Figure 4.1.10-3 is displayed in response to the 
Close button on the Mode Manager Main screen. This dialog verifies that the operator intends to 
Close (exit) the Main screen. 

Figure 4.1.10-3. Mode Manager Question Dialog 

For a description of the ECS Mode Manager Question Dialog, see Table 4.1.10-3 below. 

Table 4.1.10-3. Mode Manager Question Dialog Field Descriptions 
Option/Field Action Description 

CLOSE button Click on button Confirm that the Mode Manager Main screen is to be 
CLOSEd. 

CANCEL button Click on button Cancel the effect of the CLOSE button on the Mode 
Manager Main screen. 

4.1.10.3 Required Operating Environment 

Mode Management Service requires Open View running in the UNIX environment.. 

For information on the operating environment, tunable parameters and environment variables of 
Mode Management Service refer to the 920-TDx-013 “Custom Code Configuration Parameters” 
documentation series. The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC 
DAAC. 

4.1.10.3.1 Interfaces and Data Types 

Using OpenView and DCE, the Mode Manager GUI exchanges mode management information 
between the network management platform at the DAAC and all the managed hosts in the network. 
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 4.1.10.4 Databases 

No database is associated with or used by the ECS Mode Management Service. The Active and 
Available Modes Lists are flat files used by the Mode Manager GUI. 

4.1.10.5 Special Constraints 

Necessary setup required to access information on any ECS Host, using ECS Mode Manager GUI: 

1. HP OpenView must be running. 

2. A Sub-Agent must be running in the background (e.g., MsAgSubAgent ). 

A Deputy Agent should be running in the background (e.g., MsAgDeputy). The Network 
Management Platform will export the Modes List subdirectory to the /tools/CMS mount point. 
All ECS hosts will mount /tools/CMS to access the single copy of the Active and Available Mode 
Lists. 

4.1.10.6 Outputs 

Outputs consist of the information displayed on the screens discussed in Section 4.1.10.2 and 
messages to stout and stderr. 

4.1.10.7 Event and Error Messages 

Error messages are sent to stout and stderr. 

4.1.10.8 Reports 

None. 
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4.1.11 ECSAssist 

The ECS Assistant (ECSAssist) is a custom program that simplifies the process of installation, 
testing and management of ECS. This utility is basically an installation tool that has practical 
application in the operations environment. The tool is for use in installing software and 
maintaining the information related to that software. Only the Subsystem Manager function of 
ECSAssist should be used in the ECS operational environment. 

Table 4.1.11-1 summarizes the functions that ECSAssist supports. 

Table 4.1.11-1. Common Tasks Performed with ECSAssist 
Task Description When and Why to Use 

Subsystem 
Manager actions 

Selections on the Subsystem 
Manager’s screen, see section 
4.1.11.2.1 

Installing software and performing 
maintenance on software parameters. 

Cleanup Removes CDS entries. When it is necessary to remove a CDS 
entry 

Database Used to install, drop, patch, and 
update subsystem specific 
databases. 

When database updates or upgrades 
are implemented. See section 
4.1.11.2.1.1 .and 4.1.11.2.1.1.1 . 

Install Used to install ECS custom software 
into the selected mode. 

As necessary to install software. . See 
section 4.1.11.2.1.2 . 

Kill Kills Remove the programs selected in the 
Component, Application, and 
Executables fields. 

Mkcdsentry Makes CDS entries for servers within 
the selected component. 

As necessary to provide CDS entries. . 
See section 4.1.11.2.1.3 . 

Mkcfg Creates CFG, ACFG and PCFG files 
for selected components. 

When installing or updating software 
components. . See section 
4.1.11.2.1.4 . 

Monitor Monitors any server activity. As desired for monitoring. See section 
4.1.11.2.1.6 . 

Package Not available in Version 2.0. 

Stageinstall Used to capture the location of the 
delivered software staging area. 

As desired to identify a staging area. 
See section 4.1.11.2.1.7 . 

Start Used to start servers within the 
selected component. 

When HP OpenView is not available to 
perform this action.. 

Viewlog Used to view server log files. As desired to view log files. See section 
4.1.11.2.1.8 . 

Uninstall Not available in ECS Rel. 5B. 

ESDT Manager Not available in ECS Rel. 5B. 
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4.1.11.1 Quick Start Using EcsAssist 

ECS Assist is a custom software product for ECS. Its origin as a development tool provides 
“fallback” functionality for other tools, such as HP OpenView. 

4.1.11.1.1 Invoking EcsAssist From the Command Line Interface 

To execute ECSAssist from the command line prompt use the following procedure:�

>setenv DISPLAY <current_host>�

>setenv ECS_HOME /usr/ecs�

>setenv TK_LIBRARY /tools/lib/tk4.2


Mount point called /tools must be mounted.�

File /tools/common/ea must exist in the path. (This can be set in the .cshrc or .kshrc file)�

>EA or, if this alias is not available, use:�

> /tools/common/ea/EcCoAssist /tools/common/ea &


A screen labeled "Thanks for choosing ECS Assistant" will appear for 5 seconds.�

4.1.11.2 ECSAssist Main Screen 

The ECSAssist Main Screen shown in Figure 4.1.11-1 identifies the user and host machine. From 
the ECSAssist Main Screen the user may select the ECSAssist functions described in Table 4.1.11­
2 below. 
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Figure 4.1.11-1. ECSAssist Main Screen. 

Table 4.1.11-2 below summarizes the menus and options available on the ECSAssist Main Screen. 
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Table 4.1.11-2. ECSAssist Options and Field Descriptions


Option/Field Action Description 

File 

View Task Output 
file 

In the File menu, click View Task 
Output File. 

Allows users to view and/or print the 
results of any executed tasks. 

Preferences In the file menu, click Preferences. Allows users to select preferences. 

Exit Terminate use of tool To Quit tool 

Help Click on Help on the Subsystem 
Manager Screen Toolbar. 

Pulls down menu showing “Contents”, 
“Read Me” and “About” selections. 

User: Host: Site: 
View: (labels) 

Display only Provides labels for the field to the right. 

User: Host: 
(display) 

Automatically displayed. Displays the current host and user. 

Subsystem 
Manager 

Perform software installation and 
maintenance functions. 

See Section 4.1.11.2.1 

ESDT Manager  Not available in Release 5B. 

E.A.S.I. Clicking this button invokes the 
ECSAssist Simple Installation 
option. 

Allows one user to facilitate a 
complete(FULL) or custom installation 
of ECS software. 

4.1.11.2.1 The ECSAssist Subsystem Manager screen


In the ECSAssist Main Screen select Subsystem Manager.�

Figure 4.1.11-2 below presents the ECSAssist Subsystem Manager screen.�
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Figure 4.1.11-2. Subsystem Manager Screen 
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For a description of the Subsystem Manager Toolbar, see Table 4.1.11-3 below. 

Table 4.1.11-3. ECSAssist Subsystem Manager Toolbar (1 of 2) 
Option/Field Action Description 

File Click on File on the 
Subsystem Manager screen 
Toolbar. 

Pull down menu showing Save As and Close 
selections. 

ESDT Manager In the File menu, click on 
ESDT Manager. 

Used to configure(copy) descriptor files and 
associated shared objects to the proper 
location. 

View Task Output File In the File menu, click View 
Task Output File. 

Allows users to view and/or print the results of 
any executed tasks. 

Remove Task Output 
File 

In the File menu, click 
Remove Task output File. 

Allows users to remove the file containing 
installation specific results. 

Preferences In the file menu, click 
Preferences. 

Allows users to select preferences. 

Exit In the file menu, click Exit. Exits Subsystem Manager. 

Tools 

Browse Directories In the Tools menu, click 
Browse Directories. 

Allows users to locate files and display or print. 

Clean Logs In the Tools menu, click Clean 
logs. 

Allows users to remove outdated log files. 

Playback Commands Not available in Version 3.0. 

Refresh In the Tools menu, click 
Refresh. 

Allows users to copy control files in the 
selected mode. 

Retrofit In the Tools menu. Click on 
Retrofit. 

Re-copies script, binary, libraries and control 
files into the selected mode. 

System Messages In the Tools menu. Click on 
“System Messages”. 

Displays system messages, from /var/adm. 

Re-Read .sitemap file In the Tools menu. Click on 
“Re-read .sitemap file”. 

If there is a change to the .sitemap file, this 
function re-reads to obtain the latest 
information. 

Options Not available in Release 5B 

Feedback Not available in Release 5B. 
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Table 4.1.11-3. ECSAssist Subsystem Manager Toolbar (2 of 2)

Option/Field Action Description 

Latest Info Click on Latest Info button Displays new updates, if any, for ECSAssist. 

Extensions Click on extensions button Pulls down menu showing a list of 
subsystem specific executables used for 
supporting tasks. 

Help Menu Click on Help on the 
Subsystem Manager Screen 

Toolbar. 

Pulls down menu showing “Contents”, 
“Read Me” and “About” selections. 

Common Tasks 

Cleanup Click on cleanup button Removes CDS entries. 

Database Click on database button Used to install, drop, patch, and update 
subsystem specific databases. 

Install Click on install button Used to install ECS custom software into the 
selected mode. 

Kill Click on kill button Kills all user-selected (highlighted) 
components, applications, and executables 
in the Subsystem Manager window. 

Mkcdsentry Click on mkcdsentry button Makes CDS entries for servers within the 
selected component. 

Mkcfg Click on mkcfg button Creates CFG, ACFG and PCFG files for 
selected components. 

Monitor Click on monitor button Monitors any server activity. 

Package Not available in Version 2.0. 

Stageinstall Click on stageinstall button Used to capture the location of the staging 
area. 

Start Click on start button Used to start servers within the selected 
component. 

Viewlog Click on viewlog button Used to view server log files. 

Uninstall Not available in Version 2.0. 

For a description of the Subsystem Manager Fields, see Table 4.1.11-4 below. 
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Table 4.1.11-4. ECS Assist Subsystem Manager Field Descriptions


Option/Field Action Description 

Modes Click Select the mode. 

New Click Create a new mode. 

Refresh Click Refresh the Mode display using the source of the 
Mode information. This is useful after a New mode. 

Subsystems Click Select the subsystem resulting in a list of available 
components in the “Component” field. 

Components Click Select the component resulting in a list of available 
application in the “Applications” field. 

Applications Click Select the application resulting in a list of available 
programs in the “Executables” field. 

Executables Click Select the program displayed. 

Results Display only Displays the captured the results of executed tasks. 

Settings Display only Lists user’s current selections. 

Installation 
Statistics 

Display only List installation specific statistics. 

Installed 
Subsystems 

Display only Used as legend. When an install task has completed, a 
color of Yellow, Red or Green highlights the selected 
subsystem to denote the severity of the install as 
follows: 
Green - Perfect installation 
Yellow - Install warnings 
Red - Install errors 

4.1.11.2.1.1 ECSAssist Subsystem Manager’s “database” screen 

The Database Configuration Screen is used to install, drop, patch, and update subsystem specific 
databases. From the ECSAssist Subsystem Manager screen click the database button to initiate the 
database process. If there is more than one database parameter file (.dbparms) detected when the 
database button is pressed, ECSAssist will ask which one to use with the Select a File popup 
window shown in Figure 4.1.11-3. The listbox in the lower half of this popup above the “Ok” 
button contains the name of the database parameter files which were detected. 
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Figure 4.1.11-3. File Selection Popup Window 

The user selects one of the .dbparms files to use and then clicks on the Ok button. The fields for 
this screen are described in Table 4.1.11-5. 

Table 4.1.11-5. Database Parameter File Selection Field Descriptions 
Option/Field Action Description 

Select A file Display only Window listing detected database parameter 
files detected. 

Listbox Click on desired 
parameter file 

Select file of choice; enables Ok button. 

O k  Click Launches database script screen associated 
with the selected parameter file in the listbox 

On selection of a .dbparms file, ECSAssist next brings up the Database Configuration Screen 
shown in Figure 4.1.11-4. 
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Figure 4.1.11-4. Subsystem Manager “database” Screen 

Table 4.1.11-6 describes the fields displayed on the "database" screen. 

Table 4.1.11-6. ECS Assist Subsystem Manager’s “database” 
Field Descriptions 

Option/Field Action Description 

Database Config Screen Display only Window title 

EcDsSrDbBuild Display only Component passed from the Subsystem Manager 
screen 

SQSSERVER Entry Configurable item for the displayed Component 

GROUPNAME Entry Configurable item for the displayed Component 

ENVIRONMENT Entry Configurable item for the displayed Component 

O K  Click Displays the database script screen 

Cancel Click Aborts process 

4.1.11.2.1.1 ECSAssist Subsystem Manager’s “database script” screen 

This screen is triggered from the ECSAssist Subsystem Manager’s “database” screen, section 
4.1.11.2.1.1 above. The screen is used to input the parameters to set up the database. In the 
ECSAssist Subsystem Manager’s database script screen, the user must enter all parameters to 
initiate the respective database script. 

Figure 4.1.11-5 presents the database screen. 
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Figure 4.1.11-5. Subsystem Manager “database script” Screen 

Table 4.1.11-7 describes the control and information fields on the "database script" window. 

Table 4.1.11-7. ECS Assist Subsystem Manager’s “database script” 
Field Descriptions 

Option/Field Action Description 

Database Script 
Parameters 

Display only Window title 

EcDsSrDbBuild Display only Title 

Mode Display only Displays selected mode. 

DBO ID Entry Enter dbo id 

Password Entry Enter password 

SQL Server Name Entry Enter sql server name 

Database Name Entry Enter database name 

O K  Click Initiates process 

Cancel Click Aborts process 

4.1.11.2.1.2 ECSAssist Subsystem Manager’s Install screen 

This screen is used to install ECS custom software into the selected mode. From the ECSAssist 
Subsystem Manager screen click the install button to initiate the installation process. 

Figure 4.1.11-6 below presents the Install screen. 
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Figure 4.1.11-6. Subsystem Manager Install Screen 

Table 4.1.11-8 describes the control and information fields on the install screen. 
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Table 4.1.11-8. ECS Assist Subsystem Manager Install

Field Descriptions


Option/Field Action Description 

Installation Type Display only Heading. 

Development Click Creates symbolic links to ClearCase. 

Normal Click Copys binaries and libraries to selected mode. 

Staging Area Click Installs Mode from staging area. 

Source File 
Location 

Display only Heading. 

Stage Click To obtain files from the nightly build. 

Non Stage Click Allows testing of changes before a merge to branch is 
performed. 

Standard Click Default setting. Used to list available packages. 

Custom Click Not available in Release 4. 

Packages Display only Heading. 

Overwrite site 
specific 
configuration values 

Display only Heading 

Yes Click Use site specific .cfgparms and .dbparms file. 

N o  Click Do not use site specific .cfgparms and .dbparms file. 
Allow user to make selection of choice. 

O k  Click Executes installation process. 

Cancel Click Aborts Installation process. 

4.1.11.2.1.3 ECSAssist Subsystem Manager “mkcdsentry” screen 

Pressing the “mkcdsentry” button on the Subsystem Manager screen evokes the DCE Cell Admin 
Password screen shown in Figure 4.1.11-7. On entering the proper password and then clicking 
the Ok button, DCE Cell Directory Service (CDS) entries for servers within the selected component 
are created. 

Figure 4.1.11-7. Subsystem Manager “mkcdsentry” Screen 

Table 4.1.11-9 describes the control and information fields on the "mkcdsentry" window. 
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Table 4.1.11-9. ECS Assist Subsystem Manager mkcdsentry Field

Descriptions


Option/Field Action Description 

DCE Cell Admin Password Display only Window title 

Password Entry Enter Cell Admin Password. Has to be entered by 
DCE cell administrator. 

O k  Click Creates keytab files to be used by DCE. 

Cancel Click Aborts CDS entry process. 

4.1.11.2.1.4 ECSAssist Subsystem Manager’s mkcfg file selection screen 

The mkcfg file selection window shown in Figure 4.1.11-8 allows an user to select a .cfgparms 
file with configuration values that were entered by user or should be used when starting servers. 

Figure 4.1.11-8. mkcfg File Selection Window 

Table 4.1.11-10 describes the control and information fields on the configuration selection 
window. 

Table 4.1.11-10. mkcfg File Selection Window Field Description 
Option/Field Action Description 

Select A file Display only Window title. 

Listbox Click Select file of choice; enables Ok button. 

O k  Click Launches configurable parameters screen. 
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4.1.11.2.1.5 ECSAssist Subsystem Manager’s “mkcfg” screen 

Clicking the “mkcfg” button on the ECSAssist Subsystem Manager screen brings up the “mkcfg” 
window shown in Figure 4.1.11-9. Through this screen ECSAssist creates CFG, ACFG and 
PCFG files for selected components. 

Figure 4.1.11-9. Subsystem Manager “mkcfg” Screen 

Table 4.1.11-11 describes the control and information fields on the "mkcfg" screen. 

Table 4.1.11-11. ECS Assist Subsystem Manager mkcfg 
Field Descriptions 

Option/Field Action Description 

Configurable Parameters Display only Window title. 

EcDsHdfEosServer Click Allows user to configure EcDsHdfEosServer. 

EcDsScienceDataServerCli 
e n t  

Click Allows user to configure 
EcDsScienceDataServerClient. 

EcDsScienceDataServer Click Allows user to configure EcDsScienceDataServer 
. 

EcDsSdSrvGui Click Allows user to configure EcDsSdSrvGui. 

EcDsSdSrvGuiMkcfg Display only 

DSServerUR Enter User enters specific data to DSServerUR 

O k  Click Executes configuration process. 

Cancel Click Aborts configuration process. 

Print Click Prints configuration parameters. 
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4.1.11.2.1.6 ECSAssist Subsystem Manager’s “monitor” screen 

Clicking the “monitor” button on the ECSAssist Subsystem Manager screen brings up the 
“monitor” screen shown in Figure 4.1.11-10. This screen monitors the status of server activity on 
an ECS host. 

Figure 4.1.11-10. Subsystem Manager “monitor” Screen 

Table 4.1.11-12 describes the control and information fields on the "monitor" screen. 
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Table 4.1.11-12. ECS Assist Subsystem Manager’s monitor Field

Descriptions


Option/Field Action Description 

ECS Monitor Display only Window title 

Mode Display only Displays the current mode. 

Subsystem Display only Displays the selected subsystem. 

Component Display only Displays the selected component. 

Hostname Display only Displays the hostname. 

User Id Display only Displays the user’s id. 

Date Display only Displays the date. 

Exit Click Exits monitoring process. 

Update Now Click Refreshes the monitor screen. 

Cdsping all servers… Click Display a list of server processes and their statuses. 

Auto Update Toggle When set to on, the monitor will refresh itself. 

4.1.11.2.1.7 ECSAssist Subsystem Manager’s “stage install” screen 

The stage install screen is used to input the staging location where the delivered software is stored. 
From the ECSAssist Subsystem Manager screen click the stageinstall button to initiate the viewlog 
process 

Figure 4.1.11-11 below presents the stage install screen. 

Figure 4.1.11-11. Subsystem Manager “stageinstall” Screen 

Table 4.1.11-13 describes the control and information fields on the stageinstall window. 
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Table 4.1.11-13. ECS Assist Subsystem Manager stageinstall Field

Descriptions


Option/Field Action Description 

stage Display only Window title 

Provide staging area source 
location 

Display only Label for input field immediately below. 

Input field Input Type in the staging area filename 

O k  Click Accepts the user’s entry 

Cancel Click Aborts the process 

4.1.11.2.1.8 ECSAssist Subsystem Manager’s “viewlog” screen 

This screen is used to view server log files. From the ECSAssist Subsystem Manager screen click 
the viewlog button to initiate the viewlog process. 

Figure 4.1.11-12 below presents the viewlog screen. 

Figure 4.1.11-12. Subsystem Manager “viewlog” Screen 

Table 4.1.11-14 describes the control and information fields on the viewlog screen. 

Table 4.1.11-14. ECS Assist Subsystem Manager’s viewlog Field 
Descriptions 

Option/Field Action Description 

Log Viewer Display only Window title 

File Display only Displays the current mode. 

Quit Display only Displays the selected subsystem. 

Components Display only Displays the selected component. 

D M  Display only Subsystem DM. Select this entry to view logs for the 
subsystem DM. 

D S S  Display only Subsystem DSS. Select this entry to view logs for the 
subsystem DSS.. 

INGEST Display only Subsystem INGEST. Select this entry to view logs for 
the subsystem INGEST. 
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4.1.11.2.2 ECSAssist ESDT Manager 

Not available in Release 5B. 

4.1.11.2.4 Ecs Assistant System Installer ( E.A.S.I. ) 

E.A.S.I facilitates a complete or partial installation of ECS software, creation of configuration and 
keytab files (CDS entries), and execution of database operations by a single user who is familiar 
with the proper installation instructions. 

Figure 4.1.11-13 shows the E.A.S.I. Installation Source window which comes up as a result of 
hitting the “E.A.S.I.” button on the ECSAssist main window. 

Figure 4.1.11-13. E.A.S.I. Installation Source Window 

Table 4.1.11-15 describes information and control fields on this window. 
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Table 4.1.11-15. ECS Assist E.A.S.I Installation Source Field

Descriptions


Option/Field Action Description 

Mode (combo box) Click To view a list of available modes. User can select one 
mode. 

Enter staging area source 
location below 

Display only Staging area source location field identifier. 

Staging area source 
location entry 

Enter if 
available 

Staging area source location entry becomes available 
when a ClearCase view is not available. Enter the 
staging area source location without the architecture 
and with the word “TOOLKIT”. 
e.g. /net/tacoma/dist/DROP50 

Type of installation Display only Identifies the installation options. 

Full Click Facilitates a complete installation of ECS custom 
software. 

Custom Click Allows the user to facilitate a customized installation. 
e.g. The user may only want to install on three hosts 
or may only want to install Subsystem DSS on all 
hosts. 

Cancel Click Returns user to ECS Assist main menu. 

Next Click When enabled, allows user to proceed to next 
window. 

Figure 4.1.11-14 is the E.A.S.I. Phase Selections window. The user can select any phase to 
execute. Associated phase windows are displayed depending on what phases are selected . 

Figure 4.1.11-14. E.A.S.I. Phase Selection Window
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Table 4.1.11-16 describes the control and information fields on the E.A.S.I. Phase Selection 
window. 

Table 4.1.11-16. ECS Assist E.A.S.I Phase Selection Window Field

Descriptions


Option/Field Action Description 

Execution 
Phases 

Display Only Identifies the option buttons for selecting phase of 
installation. 

Install Click on/off Selects installation of ECS custom software 

Config Click on/off Selects the creation CFG, ACFG and PCFG files 

Create Key 
File(s) 

Click on/off Selects the creation of keytab files 

Dbase(s) Click on/off Selects the execution of selected database operations 

Cancel Click Returns user to ECS Assist main menu. 

Back Click Returns user to previously selected window. 

Next Click Allows user to proceed to next window. 

Figure 4.1.11-15 is the E.A.S.I. Installation Parameters window. It allows the user to select 
Installation criteria. If a ClearCase task is not set or not available, the Installation Type will default 
to Staging Area option . 

Figure 4.1.11-15. E.A.S.I. Installation Parameters Window
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Table 4.1.11-17 describes the control and information fields in the E.A.S.I. Installation Parameters 
window. 

Table 4.1.11-17. ECS Assist E.A.S.I Installation Parameters Window

Field Descriptions


Option/Field Action Description 

Installation Type Display Only Identifies the three installation type options. 

Development Click Creates symbolic links to ClearCase 

Normal Click Copy binaries and libraries to selected mode. 

Staging Area Click Installs mode from staging location. 

Source File Location Display only Identifies the two options for selecting source file. 

Stage Click To obtain files from the nightly build 

Non Stage Click Allows testing of changes before merge to branch 

Cancel Click Returns user to ECS Assist main menu. 

Back Click Returns user to previously selected window. 

Next Click Allows user to proceed to next window. 

Figure 4.1.11-16 is E.A.S.I CDS Password window which requests the Cell Administrator’s 
password. This password is need to allow for the creation of keytab files. 

Figure 4.1.11-16. E.A.S.I. CDS Password Window 
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Table 4.1.11-18 describes the control and information fields in the E.A.S.I. CDS Password 
window. 

Table 4.1.11-18. ECS Assist E.A.S.I CDS Password Window Field

Descriptions


Option/Field Action Description 

Cell Admin Password Display Only Identifies the Cell Admin Password entry field. 

Cell Admin Password Entry Enter 
password 

Enter password to facilitate the creation of keytab files 

Cancel Click Returns user to ECS Assist main menu. 

Back Click Returns user to previously selected window. 

Next Click Allows user to proceed to next window. 

Figure 4.1.11-17 is the E.A.S.I. Database Operations window. Select an operation other than 
“Clear” and the subsystem specific script parameters will be displayed. Enter the correct 
information for selected subsystem. You will notice that there is a tab for only subsystems that 
require database operations. 

Figure 4.1.11-17. E.A.S.I. Database Operations Window
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Table 4.1.11-19 describes the E.A.S.I. Database Operations window control and information 
fields. 

Table 4.1.11-19. ECS Assist E.A.S.I Database Operations Window

Field Descriptions


Option/Field Action Description 

Operations Display Only Identifies the button selectable Dbase options. 

DbBuild Click Facilitates execution of database build operation. 

DbDrop Click Facilitates execution of database drop operation 

DbDump Click Facilitates execution of a database drop operation. 

Dbpatch Click Facilitates execution of a database patch operation. 

DbLoad Click Facilitates execution of a database load operation 

DbValids Click DSS Science Data Server only. Facilitates execution 
of Valids script for use with ESDTs. 

Subsystems 
specific 
script 
parameters 

Display Only Heading. By selecting a tab, the heading will change 
according to selection. 

Mode Display only Displays selected mode 

Dbo Id Entry Enter Dbo Id 

Password Entry Enter password 

SQL Server 
Name 

Entry Enter SQL server name 

Database 
Name 

Entry Enter database name 

Cancel Click Returns user to ECS Assist main menu. 

Back Click Returns user to previously selected window. 

Next Click Allows user to proceed to next window. 

Figure 4.1.11-18 is the E.A.S.I Installation Confirmation window. If there is an incorrectly 
selected item, click the “Back” button until you have reached the window that requires the change 
and make the change. When change is made click the “Next” button until you have reached the 
“Installation Confirmation” window. 
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Figure 4.1.11-18. E.A.S.I Installation Confirmation Window 

Table 4.1.11-20 describes the control and information fields in the E.A.S.I. Installation 
Confirmation window. 

Table 4.1.11-20. ECS Assist E.A.S.I Installation Confirmation Window 
Field Descriptions 

Option/Field Action Description 

Please review information 
below 

Display Only Requests user to review the information immediately 
below in a scrollable text box. 

Information in Text Box Read only Contains log of installation. 

Cancel Click Returns user to ECS Assist main menu. 

Back Click Returns user to previously selected window. 

Next Click Allows user to proceed to next window. 
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Figure 4.1.11-19 is the E.A.S.I STATUS window. 

Figure 4.1.11-19. E.A.S.I. STATUS Window 

Table 4.1.11-21 describes the control and information fields in the E.A.S.I. STATUS window. 
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Table 4.1.11-21. ECS Assist E.A.S.I. STATUS Window

Field Descriptions


Option/Field Action Description 

Utilities Menu 

Close all open sockets Click Closes all opened connections. Waits for 4 minutes 
and resets communication and selected phases to 
“waiting”. This allows users to re-run selected phases. 

Max Requests Click Controls the number of server calls over the network. 

COMM (Button) Click Initiates the communication phase. Starts servers on 
selected hosts. 

INSTALL (Button) Click Initiates installation of ECS custom software 

CONFIG (Button) 
Click Initiates the creation of CFG, ACFG and PCFG files. 

CDS (Button) Click Initiates creation of keytab files. 

Status Bar (Status 
Indicator) 

Not available 

Cancel Click Returns user to ECS Assist main menu. All 
connections to the server are terminated. 

Back Click Returns user to previously selected window. 

Next Click To be used in later releases 

4.1.11.3 Required Operating Environment 

For information on the operating environment, tunable parameters and environment variables of 
ECSAssist refer to the 920-TDx-013 “Custom Code Configuration Parameters” documentation 
series . The “x” refers to the installed location, e.g. 920-TDG-013 is for GSFC DAAC. 

4.1.11.3.1 Interfaces and Data Types 

None. 

4.1.11.4 Databases 

No database is associated with or used by the ECSAssist. ECSAssist may create entries in the 
CDS catalog, create configuration files for software components, remove outdated log files, or 
update other files related to the functions performed. 

4.1.11.5 Special Constraints 

None. 
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4.1.11.6 Outputs 

Output from the ECSAssist tool consists of the data displayed on the GUIs described in 
Section 4.1.11.2.1 and error and event messages described in Section 4.1.11.7 

4.1.11.7 Event and Error Messages 

Event and Error Messages for ECSAssist are listed in Appendix A in Section 2.7.5. All outputs 
associated with ECS Assistant are captured in a file call /tmp/<userid>.ecs_session.log. 

4.1.11.8 Reports 

None. 
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